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 L’outil gratuit d’animation 
et de graphisme 3D
Logiciel libre de référence pour la création d’images 
et l’animation 3D, Blender n’a rien à envier à XSI, 3ds 
Max ou Maya. Grâce à son interface intelligente et 
contextuelle, il permet à l’artiste d’allier productivité 
et créativité. Très ouvert, il met à sa disposition de 
nombreux moteurs de rendu photoréaliste et s’intègre, 
par sa richesse et sa flexibilité, à la panoplie des outils 
de travail quotidiens du graphiste professionnel.
La septième édition de ce livre porte sur Blender 2.8, 
version qui s’est enrichie d’un outil d’animation 2D 
complet et d’un moteur de rendu temps réel.

Libérez vos images et animations 3D !
�  Modélisez de façon puissante les objets, les compo-

sants mécaniques et les formes organiques.
�  Maîtrisez la modélisation polygonale et les outils 

de sculpture interactive.
�  Simulez et animez des personnages, fluides et corps 

souples (vêtements, fourrures et chevelure que vous 
pouvez sculpter et coi�er), feux et fumées.

�  Habillez-les par des matériaux et des textures peintes 
ou photographiées.

�  Jonglez avec l’éditeur de nœuds pour concevoir 
des shaders complexes et créer des e�ets spéciaux.

�  Éclairez vos scènes avec réalisme et e�ectuez le 
rendu grâce aux moteurs libres Blender, Eevee et 
Cycles.

�  Montez vos animations directement dans Blender.
�  Perfectionnez vos animations 2D grâce aux dernières 

évolutions de l’outil Grease Pencil.
�  Découvrez des nouveaux outils de sculpture 3D 

perfectionnés.
�  Échangez avec d’autres applications via divers formats

image, vidéo ou moteurs de jeux (3D Studio, 
Collada, LightWave, XSI, DirectX, VRML, FBX, Doom �3, 
Quake 3, PNG, JPEG, TARGA, AVI...).
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À qui s’adresse cet ouvrage ?
� Aux amateurs d’images de synthèse ou 

d’animation 3D, sous Windows, Linux
et Mac OS X

�  Aux utilisateurs de 3ds Max, Maya, 
ZBrush qui souhaitent retrouver en 
gratuit et libre des outils de création 
3D avancés

Sur la la fiche du livre sur
www.editions-eyrolles.com/dl/0067714
Blender 2.8 pour Windows, macOS et Linux, 
avec Luminance HDR 2.6.0 • Exercices corrigés 
• Matériaux et textures du Blender Texture Disk 
prêts à l’emploi • Courts-métrages Elephants 
Dream, Big Buck Bunny, Sintel, Tears of Steel, 
Cosmos Laundromat, Agent 327�: Opération 
Barbershop et Spring (formats .mov, .avi et 
.ogg) • Nombreux bonus. 

Configuration recommandée : Windows Vista, 
7, 8, 10, Linux ou macOS, processeur 64 bits 
Quad Core, 8 Go de RAM, écran full HD, souris 
ou trackpad, carte graphique OpenGL avec 2 
Go de RAM, 150 Mo d’espace disque.

Utilisateur de Blender depuis 1999, Olivier 
Saraja a été l’un des animateurs de la com-
munauté du graphisme libre – en particulier 
sous Linux. Il s’est entouré d’Henri Hebeisen, 
infographiste 3D et auteur de formations vidéo, 
et de Boris Fauret, artiste français, qui partagent 
sa volonté de faciliter l’accès à Blender au plus 
grand nombre dans les communautés françaises 
et anglophones. 
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Ce livre possède un format un peu particulier, situé quelque part entre le
manuel d’utilisation et le recueil de didacticiels. Il vise à présenter de façon
synthétique à peu près tout ce qu’il est possible de réaliser avec Blender,
mais aussi à guider pas à pas ceux que les images de synthèse peuvent
effrayer, mais qui voudraient malgré tout tenter leur chance. Malheureuse-
ment, il n’a pas été possible de tout mettre, référencer et présenter
(Blender est un logiciel tellement riche en possibilités !). Aussi parfois, des
choix douloureux ont été effectués avant de figer le contenu d’un chapitre.

Pendant de longues années, j’ai écrit des didacticiels sur l’usage de
Blender (et d’autres logiciels libres d’images de synthèse) et j’ai même eu
l’occasion de collaborer avec l’équipe de rédaction de la documentation
officielle. En effet, la liste des fonctionnalités nouvelles de Blender
s’allongeant très vite, les auteurs habituels n’arrivaient pas à écrire la
documentation à un rythme aussi rapide ; il aurait fallu un temps certain
pour que le retard soit rattrapé sans la bonne volonté d’une poignée de
volontaires. Nous savions que la documentation resterait un chantier
perpétuel, mais c’était manifestement le prix à payer si l’on désirait sou-
tenir un outil en constante évolution. L’écriture de La 3D libre avec
Blender avait donc lentement mûri en moi, mais il fallut une rencontre
opportune et la sortie du livre Gimp 2 efficace de Cédric Gémy (égale-
ment aux éditions Eyrolles) pour concrétiser ce projet latent.

Depuis, la première édition a fait son bonhomme de chemin et a été très
favorablement accueillie par la communauté francophone des utilisateurs
de Blender. J’ai appris avec fierté (et soulagement !), à travers vos nom-
breux et chaleureux courriels, que mes modestes connaissances, accumu-
lées au fil de plusieurs années d’écriture de didacticiels, d’articles et de
bouts de documentation, avaient pu aider à rendre abordable un logiciel
réputé (à tort) comme difficile d’accès. C’est donc naturellement que,

Avant-propos

3DS MAX, MAYA
Vitesse de développement

Le développement de 3ds Max est réputé très lent,
certains bogues datant de quatre versions anté-
rieures n’étant toujours pas corrigés. En revanche,
dans le passé, le développement de Maya a été
plutôt rapide, mais depuis son rachat par Autodesk
(l’éditeur de 3ds Max), il convient de s’accorder le
temps de juger. Pour sa part, depuis que le code
source de Blender a été racheté par la commu-
nauté et que le logiciel est devenu libre, le déve-
loppement de Blender a été si rapide que
maintenir à jour la documentation est une
gageure.
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porté par ce succès et cet accueil fantastique, cet ouvrage refait son appa-
rition dans une septième édition, complètement refondue et enrichie,
pour tenir compte tant des progrès de Blender que de sa richesse en per-
pétuelle expansion.

Et des progrès, Blender en a connu des quantités, ces dernières années,
au point qu’il m’a fallu m’entourer de deux jeunes talents de la scène
francophone pour continuer à maintenir et enrichir cette bible que
constitue cet ouvrage pour nombre d’entre vous. J’ai nommé Henri
Hebeisen et Boris Fauret, et toute leur expertise n’aura pas été de trop
pour faire face à la restructuration monumentale du logiciel qui se maté-
rialise sous les traits de la version 2.80 de Blender, avec pour ambition de
remettre la création artistique au centre de l’écran.

Et cette stratégie a été clairement payante si l’on considère toutes les
améliorations qui ont fait leur apparition dans cette nouvelle branche
2.80 : une nouvelle interface avec ses espaces de travail ; un nouveau
moteur d’affichage temps réel (Eevee) directement dans les fenêtres de
modélisation, de sculpture ou de composition de vos scènes 3D ; des
outils interactifs et des gizmos pour retravailler celles-ci ; l’évolution du
Grease Pencil qui devient un système de dessin 2D et d’animation à part
entière, pour l’intégration des concept arts et des storyboards à Blender ;
les bonds en avant du moteur de rendu Cycles permettant davantage de
réalisme des matières organiques et des systèmes de chevelure ou de
fourrures, mais aussi une gestion optimisée de la mémoire ; et tellement
d’autres choses qu’il est impossible de les énumérer succinctement.

Blender se transforme mais il reste égal à lui-même : le couteau suisse de la
3D, toujours plus puissant, plus rapide, plus efficace. Pour mieux vous servir.

À qui s’adresse ce livre ?
Blender a été développé en tant qu’outil de production d’animations 3D.
Il a donc avant tout un usage professionnel et de production. Il est d’ail-
leurs étonnant de constater comme Blender devient particulièrement
efficace lorsque l’on a maîtrisé son fonctionnement général.

Blender n’oublie pas non plus les artistes, en étant très éloigné des outils
de conception ou de dessin assisté par ordinateur, précis mais arides et ne
favorisant pas la créativité personnelle. Au contraire, l’interface de
Blender est vivante, souvent fluctuante même, et semble accompagner
l’utilisateur dans ses travaux, lui permettant de se recentrer sur sa liberté
artistique plutôt que sur la rigueur nécessaire à un réalisme excessif.
2
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> Vous êtes un curieux ou un débutant
Vous n’avez jamais créé d’images de synthèse et ces mots mêmes vous
paraissent mystérieux ou insurmontables ? Vous trouverez dans cet
ouvrage une excellente introduction à l’imagerie 3D et, au terme de sa
lecture, vous vous sentirez à l’aise et capable de mener, sur la seule base
de votre créativité, vos premiers projets.

> Vous êtes déjà un utilisateur confirmé de Blender
Le développement de Blender va vite, très vite, et souvent, les nou-
veautés ne sont documentées qu’en anglais. Si vous vous sentez dépassé
par le déluge de nouveautés de chaque nouvelle version, ou si vous êtes
fâché avec la langue anglaise, alors cet ouvrage est également fait pour
vous : il reprend toutes les principales fonctionnalités de Blender (des
plus anciennes aux plus récentes) en les démystifiant ou en leur appor-
tant un éclairage particulier. Vous apprécierez alors les cas pratiques qui
parsèment le livre, à décortiquer jusqu’à ce que vous les maîtrisiez.

> Vous êtes un artiste 3D chevronné
Blender mûrit chaque jour. De plus en plus d’artistes accomplis s’y inté-
ressent ou se tournent vers lui. Outre l’avantage d’être gratuit et de béné-
ficier d’un développement dynamique, il s’efforce de se doter des outils
qui font la force des grandes applications commerciales, pour un coût…
nul ! Mais ce qui fait plaisir à lire, ce sont les commentaires d’artistes
confirmés qui s’étonnent de voir, par exemple, dans les forums de
CGTalk (http://forums.cgsociety.org), des images réalisées avec Blender, en
affirmant « [qu’ils ne savaient pas] que Blender était capable de faire
ça ! ». L’autre point de satisfaction, c’est de constater que certains ont
intégré Blender dans leur workflow, que ce soit pour le dépliage UV ou la
simulation des fluides, sans honte d’utiliser un logiciel « gratuit » là où
des confrères dépensent des centaines ou des milliers de dollars pour
aider leur créativité à s’exprimer. Si vous êtes un artiste 3D confirmé et
que vous vous demandez si Blender peut vous aider dans votre démarche
artistique ou professionnelle, ce livre est fait pour vous : il brosse dans ses
grandes lignes la liste des fonctionnalités et capacités de Blender, en les
rapprochant autant que possible de ce qui se fait avec 3ds Max ou Maya,
par exemple, afin de faciliter la transition.

REMARQUE Vous êtes familier d’un autre
grand logiciel commercial ?

Il serait illusoire d’établir des ponts permanents
entre les divers logiciels commerciaux du marché
et Blender, mais vous trouverez tout au long de cet
ouvrage des apartés expliquant les principales dif-
férences ou similitudes entres les fonctions de
Blender et celles de 3ds Max ou Maya.
3
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Blender est gratuit… vraiment ?
Oui, vraiment. Vous pouvez le copier à l’envi, le distribuer librement à tous
vos amis, collègues et connaissances. Vous pouvez l’installer sur autant de
postes que souhaité. Vous n’avez aucune limitation, ni sur son usage, ni sur
celui des œuvres réalisées avec lui. Et dans le cas où vous vous sentiriez
l’âme d’un développeur, vous pouvez même plonger votre nez dans les
sources du logiciel, voir comment fonctionnent ses arcanes internes ou
détailler les algorithmes employés : c’est la magie du logiciel libre. Blender
est à l’imagerie 3D ce que Gimp est à l’imagerie 2D : un formidable outil
de créativité, riche, puissant, fonctionnel et… totalement gratuit !

D’autres logiciels commerciaux reposent sur quantités de greffons, plug-ins
et extensions, la plupart coûteux et difficiles d’accès, pour produire des
résultats d’une qualité dépendant grandement de la compétence de l’utilisa-
teur et ce, malgré leur prix. Blender bénéficie pour sa part d’une commu-
nauté de développeurs très actifs et dispose d’une solide base de scripts
Python (des Add-Ons) qui enrichissent ses capacités naturelles. S’il lui
manque une fonctionnalité, il est certain qu’elle est véritablement inutile ou
qu’elle sera intégrée dans une très prochaine version officielle !

Enfin, je saisis l’opportunité de ce moment en votre compagnie pour
vous annoncer que cette septième édition est la dernière sur laquelle vous
lirez mon nom en tant qu’auteur. Il est temps pour moi de passer le
relais, et je sais qu’Henri et Boris auront à cœur de porter cet ouvrage
plus loin que jamais, avec talent et sincérité, tant le futur de Blender s’est
toujours révélé plein de promesses.

C’est le moment de clore cet avant-propos, et de vous plonger dans la
lecture de ce livre qui demeurera, je l’espère, votre livre de chevet !

Seysses, août 2019,

Olivier Saraja

3DS MAX
Langage de script

Le langage de script de 3ds Max lui est propre et
est assez proche du langage C. De son côté,
Blender utilise un langage très répandu, Python,
qui se révèle puissant et flexible.
4
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l’avez toujours fait jusqu’à présent.
5



G67714-3D libre avec Blender-.book Page 6 Thursday, October 17, 2019 4:06 PM



G67714-3D libre avec Blender-.book Page 7 Thursday, October 17, 2019 4:06 PM
L’ancêtre de Blender est né en 1988 au sein du studio d’animation hol-
landais NeoGeo (l’une des plus grandes sociétés d’animation 3D des
Pays-Bas, primée en 1993 et 1995 par l’European Corporate Video
Awards), société dont Ton Roosendaal fut l’un des cofondateurs. À la
suite d’une intensification des besoins internes, le logiciel fut entière-
ment réécrit et devint la suite de modélisation et d’animation 3D connue
sous le nom de Blender.

En 1998, Ton Roosendaal fonda une nouvelle entité baptisée Not A
Number (NaN) dont l’objectif était de développer et de commercialiser
Blender : l’ambition était d’offrir un outil compact, multi-plates-formes,
professionnel et gratuit, à destination d’un public très large, la société
devant vivre de la vente de produits commerciaux et de services. Blender
fit sensation à la conférence SIGGRAPH de 1999, s’attirant l’attention du
public comme de la presse et confirmant son potentiel hors du commun.

En suscitant le même engouement lors du SIGGRAPH de 2000, NaN
réussit à réunir près de 4 500 000 euros de financement, qui lui permirent
de porter ses effectifs à 50 salariés, aux Pays-Bas, au Japon et aux États-
Unis. Au cours de l’été de la même année, la version 2.0 de Blender, inté-
grant un moteur de jeu, sortait et, à la fin de l’année, Blender pouvait
revendiquer plus de 250 000 utilisateurs enregistrés. Après une réduction
d’effectif due à la frilosité du marché et la recherche de nouveaux investis-
seurs, NaN sortait fin 2001 une mouture commerciale de son logiciel,
Blender Publisher, visant le marché émergeant du contenu interactif pour
les sites web basés sur la 3D. Malheureusement, en raison de ventes déce-
vantes et d’un climat économique de plus en plus difficile, les nouveaux
investisseurs décidèrent de mettre un terme aux activités de NaN, signant
également celui du développement de Blender.

Introduction :
historique de Blender

3DS MAX, MAYA
Portabilité

3ds Max n’est disponible que sur plates-formes
Windows. Pour sa part, Maya a été porté sous
Linux afin de satisfaire aux besoins des studios
Dreamworks. Blender, en revanche, est disponible
sur à peu près toutes les plates-formes existantes
et le portage sur tablettes Android est même en
cours, à titre expérimental !
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Reprendre une nouvelle société avec une base suffisante de développeurs
salariés n’étant économiquement pas envisageable, Ton décida de créer la
Blender Foundation, une fondation à but non lucratif, pour ne pas aban-
donner la communauté enthousiaste d’utilisateurs et de clients qui pleu-
raient la disparition de Blender. En juillet 2002, Ton parvint à
convaincre les investisseurs de NaN de libérer, moyennant finances, les
sources de Blender et lança auprès de la communauté une vaste collecte
de fonds devant rapporter les 100 000 euros qui permettraient de
racheter les droits de propriété intellectuelle et le code source de Blender
aux investisseurs. À la surprise générale, il suffit de seulement sept
semaines à la communauté pour amasser cette somme considérable.
Officiellement, c’est le dimanche 13 octobre 2002 que Blender fut
libéré. Ses fichiers sources furent alors placés sous la licence GNU GPL
(General Public License).

Depuis, le développement de Blender continue, poussé par des volon-
taires dévoués dispersés sur la planète entière et toujours mené par le
créateur initial de Blender, Ton Roosendaal. Il est bien évidemment der-
rière l’essor du Blender Cloud (https://cloud.blender.org), la plate-forme de
production ouverte où sont partagés les travaux de contenus 3D, et qui
fournit des formations professionnelles. Cette structure s’est fixée pour
mission l’amélioration de la création 3D grâce aux logiciels libres/
ouverts en produisant des contenus 3D attirants et en permettant aux
développeurs et aux artistes de briller par eux-mêmes à travers leurs
propres histoires et films d’animation.

En parallèle, le financement de la Fondation Blender se poursuit grâce
aux donations, à un fonds de développement (auquel contribuent massi-
vement des acteurs majeurs du jeu vidéo, comme Epic Games ou encore
Ubisoft) ou encore le Blender Store (https://store.blender.org/). Les revenus
ainsi collectés permettent à la Fondation d’employer une quinzaine de
personnes à temps plein pour travailler sur l’amélioration de Blender. La
version 2.80 de Blender, objet du présent ouvrage, est le fruit direct de ce
nouveau modèle libre qui permet de placer un logiciel libre et gratuit au
cœur des préoccupations des standards majeurs de l’industrie.
8
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chapitre 1
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Installation de Blender

Blender est une suite complète de modélisation, d’animation,
de rendu, et même de montage vidéo parfaitement autonome,
tout en n’occupant sur le disque qu’une place très modeste en
comparaison avec les logiciels concurrents. Aussi simple
à installer que compact, ses possibilités sont également
extensibles grâce à l’usage de scripts Python ou de différents
moteurs de rendu externes avancés, non fournis et non
couverts par cet ouvrage (à l’exception de Cycles, moteur
de rendu de Blender modernisé appelé à remplacer le moteur
de rendu interne qui a fait les beaux jours du logiciel).

SOMMAIRE

B Installation de Blender

B Préférences de l’utilisateur

B Add-ons

MOTS-CLÉS

B Installation
B Blender
B Windows
B GNU/Linux
B macOS
B Francisation
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Quel que soit votre système d’exploitation de prédilection (Windows,
GNU/Linux, macOS), l’installation de Blender ne présente aucune diffi-
culté, et ce logiciel fonctionnera directement, sans configuration particu-
lière de votre part. En effet, même s’il fait usage du langage de
programmation Python 3.2 (un langage interprété, qui permet d’étendre,
grâce au scripting, les capacités de Blender en termes de modélisation,
d’animation ou de gestion de scènes complexes), toutes les bibliothèques
nécessaires sont fournies avec le logiciel. Vous n’aurez donc pas à installer
le langage Python, sauf si vous prévoyez d’écrire vous-même vos propres
extensions, ce qui n’est pas couvert par cet ouvrage.

Les principales étapes sont reprises ci-après, avec des explications un peu
plus détaillées pour l’utilisateur de Windows, parfois moins à l’aise avec
les outils informatiques.

Installation sous Windows
Blender est disponible aussi bien en version 32 bits qu’en version
64 bits ; il vous est donc nécessaire de savoir quelle est la version de votre
système d’exploitation. Deux méthodes d’installation sont systématique-
ment proposées : un fichier autoextractible .msi, dont l’assistant vous
guidera pas à pas à travers toutes les étapes de l’installation, ou un fichier
.zip à désarchiver à l’emplacement de votre choix.

La deuxième méthode est la plus directe et c’est celle que nous présenterons
ici. Vous devez bien sûr télécharger la version correspondant à votre système,
même si l’exemple traité ci-après correspond à une version 64 bits.

Téléchargez le dossier d’installation, disponible à l’adresse suivante
https://download.blender.org/release/Blender2.80/blender-2.80-windows64.zip. Décom-
pressez l’archive .zip (effectuez un clic droit sur le dossier de l’archive et
choisissez Extraire tout...). N’hésitez pas à déplacer le répertoire blender-

2.80-windows64 à un endroit plus approprié de votre disque dur. Enfin,
double-cliquez sur le fichier blender.exe pour lancer l’application.

Installation sous GNU/Linux
Comme pour Windows, il existe pour Linux des versions 32 bits et
64 bits de Blender. Dans tous les cas, ce sont des versions proposées pour
des distributions plutôt récentes (à base de glibc 2.11).

À noter que si la plupart des distributions proposent une version de
Blender qui lui est parfaitement adaptée, celle-ci aura probablement

ALTERNATIVES
Autres systèmes

De façon irrégulière et en fonction des versions de
Blender, diverses déclinaisons sont mises à disposi-
tion pour d’autres systèmes d’exploitation. Parmi
celles-ci, des versions FreeBSD et parfois même, au
rythme des contributions, Irix et Solaris, ou encore
macOS sur architecture PowerPC.
Toutefois, ces versions spécifiques ne sont pas sys-
tématiquement disponibles immédiatement après
une sortie officielle. Certaines sont disponibles sur
la page http://www.blender.org/download/
tandis que d’autres ne sont accessibles qu’après
intégration aux dépôts de logiciels officiels de
votre système d’exploitation.

PRÉREQUIS
WindowsXP et le Microsoft

Visual C++ 2013 Redistributable Package

Windows XP n’est plus (activement) supporté. Si
Blender rapporte une erreur au démarrage,
veuillez installer le Visual C++ 2013 Redistribu-
table Package que vous trouverez ici : http://
www.microsoft.com/en-us/download/
details.aspx?id=40784
12
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quelques numéros de version de retard par rapport à celle proposée par la
Fondation Blender. Nous ne présenterons donc ici, pour les besoins de
notre exemple, que la méthode d’installation de la version officiellement
distribuée sous forme d’archive .zip et en version 64 bits.

Sélectionnez la version qui vous convient le mieux en fonction de votre
système et téléchargez-la sur le site officiel de Blender (http://www.blender.org/
download/).

https://download.blender.org/release/Blender2.80/blender-2.80-linux-glibc217-x86_64.tar.bz2

Ensuite, suivez la procédure suivante :
1 Ouvrez une console.
2 Décompressez l’archive : tar jxvf blender-2.80-linux-glibc217-

x86_64.tar.bz2

Pour lancer Blender, il suffit de poursuivre avec les étapes suivantes :
3 Allez dans le dossier créé : cd blender-2.80-linux-glibc217-x86_64

4 Tapez ./blender (ou ./blender-softwaregl dans le cas où vous ne
possédez pas de carte graphique avec accélération 3D matérielle).

En fonction de votre gestionnaire de fenêtres, vous pouvez créer une
icône sur votre bureau pour lancer Blender d’un simple clic de souris.

Installation sous macOS
Les derniers binaires officiels proposés par la Fondation Blender
requièrent macOS 10.6 ou plus. Attention, il n’existe aujourd’hui plus
que des versions 64 bits de ces binaires. Vous pourrez télécharger
Blender sur le site officiel (http://www.blender.org/download/).

https://download.blender.org/release/Blender2.80/blender-2.80-macOS.dmg

Naviguez jusqu’à l’emplacement où le fichier a été enregistré et double-
cliquez dessus. Une fois le fichier .dmg ouvert, une nouvelle fenêtre
apparaît. Pour valider l’installation, il suffit de faire glisser l’icône de
Blender sur l’icône du dossier installation.

À SAVOIR
Blender et OpenGL

Blender utilise OpenGL pour tous les tracés à
l’écran des fenêtres 3D jusqu’aux menus et aux
boutons. Une carte graphique autorisant l’accélé-
ration 3D matérielle vous permettra donc d’utiliser
Blender de façon optimale. Les moins bien nantis
ne seront toutefois pénalisés que pour les scènes
les plus complexes.

OUPS !
Blender refuse de démarrer

Vérifiez-en les raisons dans une console. Il est pos-
sible que vous deviez installer un paquetage
nommé libstdc++5 (ou ultérieur). Une
recherche dans les paquets .rpm ou .deb de
votre distribution favorite devrait vous permettre
de trouver celui-ci. Dans le cas contraire, effectuez
une recherche sur Internet : les distributions sont
trop nombreuses pour que nous puissions mettre à
disposition dans cet aparté les différents liens.

Figure 1–1
Il est possible d’ouvrir le fichier .dmg
directement depuis le navigateur.
13
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Blender est installé et prêt à l’emploi. Naviguez dans le dossier Applica-
tion et double-cliquez sur l’icône Blender pour lancer le logiciel.

En même temps que l’interface du logiciel s’affichera sur votre écran,
son icône apparaîtra dans le Dock. Un clic droit (ou [Ctrl]+clic) permet
d’en afficher les Options : choisissez Garder dans le Dock.

Figure 1–2
Il suffit de glisser-déposer

l’icône pour installer le logiciel.

Figure 1–3
Blender figure désormais

dans la liste des applications.
14
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Les préférences de l’utilisateur
Avec une interface riche et largement personnalisable, les préférences de
l’utilisateur seront inévitablement une préoccupation centrale un jour ou
l’autre, aussi en livrerons-nous quelques clés dès ce chapitre. Il est pos-
sible d’afficher celles-ci au travers du menu Edit>Preferences. Elles appa-
raissent alors dans une fenêtre flottante, les différents menu étant listés
sur la partie gauche.

Personnalisation de Blender
Les paramètres de préférences sont regroupés de façon assez
conventionnelle ; la plupart sont hérités des anciennes versions de
Blender, mais autorisent désormais des réglages plus variés et plus fins.

Thèmes de couleur
C’est le cas par exemple de la catégorie Themes, qui permet de personna-
liser indépendamment chaque type d’éditeur (3D View, Node Editor, etc.)
en spécifiant la couleur de chaque élément constitutif de l’interface gra-
phique (couleur de l’en-tête, des textes, des titres, etc. pour l’éditeur
Properties ; de la grille, des points, des arêtes, des facettes sélectionnés,
etc. pour l’éditeur 3D View). Le bouton Reset permet de revenir au thème
d’origine sans avoir à renoncer aux autres modifications apportées par
l’utilisateur à la scène de démarrage par défaut.

BON À SAVOIR
Gestion des préférences utilisateurs

La scène de départ par défaut de Blender est un
cube gris flottant dans l’espace, avec une caméra et
une lampe simple. Vous pouvez préférer une scène
de départ plus élaborée, ou totalement vierge. Les
deux opérations suivantes peuvent vous y aider.
• File>Defaults>Save Startup File enregistre

la scène actuellement affichée comme étant la
future scène de départ à chaque fois que vous
lancez Blender.

• File>Defaults>Load Factory Settings réaf-
fiche la scène de départ par défaut de Blender.

Cette dernière opération ne restaure toutefois pas
la scène par défaut comme nouvelle scène de
départ : après avoir chargée la scène par défaut, il
vous faut ensuite la sauvegarder grâce à Save
Startup File.

Figure 1–4
Paramètres de personnalisation
de l’interface de Blender
15
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Paramètres liés aux périphériques d’entrée
Dans la catégorie Input, il est question de gérer le paramétrage de la
souris ou du clavier.

La souris

Blender nécessite une souris à trois boutons pour fonctionner de façon
optimale. Si votre souris ne dispose que de deux boutons classiques, vous
pouvez cocher l’option Emulate 3 Button Mouse pour que la pression
simultanée des boutons gauche et droit simule l’activation d’un bouton
central virtuel. À noter que cela ne permet en revanche pas de simuler le
défilement de la roulette.

Le clavier

L’un des points forts de Blender est la pluralité des raccourcis clavier qui,
bien maîtrisés, permettent d’augmenter considérablement la producti-
vité de l’utilisateur. Mais Blender est tellement riche en fonctionnalités
qu’il est impossible de couvrir, sans les rendre exagérément complexes à
mémoriser ou utiliser, toutes les possibilités de façon cohérente avec les
raccourcis clavier existants.

L’agencement actuel se veut optimal et généraliste. Il conviendra toute-
fois assez mal à des utilisateurs spécialisés dans un domaine (comme la
modélisation ou l’animation). À leur attention, Blender permet donc de
changer les raccourcis clavier ou de les assigner différemment.

Figure 1–5
La couleur de chaque élément de fenêtre

peut désormais être modifiée selon
les goûts de l’utilisateur.

BON À SAVOIR
Recherche du raccourci

d’une fonction particulière

Dans la catégorie Keymap, un astucieux champ
de recherche permet de localiser rapidement un
raccourci clavier à partir du nom de la fonction
associée. Par exemple, la chaîne de caractères
extrude aboutit à l’affichage des catégories
Mesh, Curve ou Armature, qui toutes per-
mettent l’extrusion de leurs éléments.

ASTUCE
Vous avez oublié un raccourci clavier?

Bien évidemment, toutes les fonctions accessibles
via les menus situés dans les en-têtes de Blender
affichent le raccourci clavier approprié lorsqu’il
existe. Toutefois, certains utilisateurs peuvent
avoir un trou de mémoire, c’est-à-dire avoir besoin
de retrouver un raccourci en un coup d’œil sans
avoir à parcourir différentes zones de l’interface
graphique. C’est ici que la catégorie Keymap des
Preferences permet de retrouver, dans une liste
synthétique, le ou les raccourcis recherchés.
16
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Les catégories sont dépliables une à une pour révéler les raccourcis clavier
existants. Le bouton Edit permet d’activer le mode autorisant la modifica-
tion de ceux-ci et le bouton Restore permet de réinitialiser le raccourci à sa
valeur originelle. Il est également possible d’exporter sa propre configura-
tion à l’usage de tiers (bouton Export) et, réciproquement, d’importer celles
mises à disposition par d’autres utilisateurs (bouton Import).

Franciser l’interface
Blender est un logiciel international, avec une mine de ressources dispo-
nibles sur Internet dans diverses langues. Pour faciliter la compréhension et
la maîtrise du logiciel pour les masses, la plupart des sites d’éditeurs ont pris
le parti de conserver, que ce soit lors des tutoriels vidéo ou écrits, l’interface
de Blender en anglais. C’est également le parti pris par cet ouvrage.

Si toutefois vous souhaitez afficher Blender en français, il vous faut aller
dans la catégorie Interface et repérer la case à cocher Translation. Vous
pouvez dans le menu déroulant choisir la langue par défaut et choisir
d’imposer la traduction aussi bien à l’interface qu’aux bulles d’aide (Tool-
tips), au choix.

Pour bénéficier au mieux des enseignements de cet ouvrage et de la plu-
part des ressources disponibles sur Internet, nous vous recommandons
de ne cocher que Tooltips. Ainsi, vous conserverez la même interface

Figure 1–6
Chaque fonction peut se voir attribuer
un raccourci clavier en fonction de son contexte
(Object Mode et Edit Mode, par exemple).
17
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internationale, mais pourrez bénéficier des explications et astuces affi-
chées dans les bulles d’aide dans votre langue maternelle.

Les modules complémentaires (add-ons)
Une grande part de la versatilité de Blender vient de l’intégration intime
de greffons, ces scripts externes qui sont distribués avec Blender ou télé-
chargeables sur différents sites de projet. Ils sont réunis sous l’appella-
tion add-ons, car ils viennent en complément de Blender, pour en
étendre les capacités.

Pour des raisons de sécurité (un script malicieux à l’intérieur de Blender
pouvant faire beaucoup de dégâts à votre système, entre autres), tous ces
add-ons sont par défaut désactivés, et vous êtes invités à n’activer que
ceux qui sont livrés par défaut avec Blender ou ceux dont la provenance
vous est connue et jugée de confiance. De plus, cela permet de maintenir
une interface dotée seulement des fonctionnalités essentielles, toujours
propre et bien organisée, sans ralentissement notable.

Figure 1–7
La francisation totale ou partielle

de Blender est possible.

BON À SAVOIR
Le catalogue officiel des add-ons

Un catalogue officiel est maintenu sur le wiki du
projet Blender, à l’adresse suivante :
B http://developer.blender.org/diffusion/BAC/
Informations, détails et parfois même documenta-
tions sont disponibles pour chacun des add-ons
présentés. En anglais seulement.

Figure 1–8
L’interface de gestion des scripts externes

permet une activation au cas par cas
des fonctionnalités qui intéressent l’utilisateur.
18
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Les add-ons disponibles sur Internet indiquent souvent comment les
installer proprement (souvent, il s’agit de copier le fichier ou le répertoire
distribué dans le répertoire scripts/addons de votre installation de
Blender), ou vous pouvez alternativement utiliser le bouton Install pour
en réaliser une installation automatique. Ils apparaissent alors dans la
liste des add-ons disponibles dans la fenêtre Blender User Preferences.

Une fois installé, un add-on n’est pas actif pour autant : il est nécessaire
de l’activer ! Il faut pour cela cocher la case qui accompagne sa descrip-
tion. Dès lors, il devient une fonction accessible par les menus appro-
priés de Blender : si vous dépliez la description complète de l’add-on
installé, le chemin d’accès dans l’interface est généralement spécifié. Par
exemple, l’add-on BoltFactory est accessible via le menu Add>Mesh>Bolt
comme s’il s’agissait d’une primitive classique, ce qui montre les efforts
d’intégration transparente qui ont été réalisés.

En théorie, cette activation n’est valable que pour le projet courant sur
lequel vous travaillez : si vous l’avez sauvegardé, Blender se souviendra
de l’activation de l’add-on à chaque réouverture du projet. Si vous sou-
haitez qu’un ou plusieurs add-ons soient disponibles dès la scène par
défaut de Blender, il vous faut activer chacun d’eux et enregistrer les
nouvelles préférences comme décrit dans l’aparté « Bon à savoir : Ges-
tion des préférences utilisateurs ».

Accélérer le rendu avec Cycles
L’une des principales innovations de Blender, ces dernières années, concerne
Cycles, son moteur de rendu photoréaliste et physiquement exact. Toutefois,
son principal inconvénient est la durée des rendus, qui est en théorie infinie.

ASTUCE S’y retrouver rapidement avec les add-ons

La bibliothèque des add-ons distribués avec Blender est plus ou moins conséquente, en fonc-
tion du numéro de version de Blender. Un champ de recherche fort commode permet donc de
trouver rapidement un add-on dont vous connaissez le nom, même si vous ignorez sa caté-
gorie. Il est également possible, pour plus de lisibilité, d’activer l’affichage des greffons selon
que le support est assuré par la Fondation Blender (bouton Official) ou par la communauté
Blender (bouton Community).
Une signalétique accompagne également chaque description :
• indique un add-on en version bêta (en cours de développement) pouvant présenter des

dysfonctionnements occasionnels ;
• indique un add-on dont la maintenance (correctifs et mises à jour) est officiellement

assurée par la Fondation Blender ;
• indique un add-on développé et maintenu par la communauté des utilisateurs de Blender.
19
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En effet, Cycles utilise exclusivement la technique du pathtracing pour cal-
culer les images. Cette méthode consiste à simuler l’illumination globale de
la scène en lançant des rayons de lumière qui vont progressivement générer
l’image finale. Au début du calcul, l’image n’est constituée que d’un nuage de
pixels qui va s’affiner progressivement jusqu’à former l’image finale. Concrè-
tement, l’image calculée est de plus en plus nette, mais elle conservera tou-
jours un léger grain. L’efficacité de l’algorithme dépend donc directement du
nombre de rayons envoyés depuis la caméra.

Afin d’accélérer les calculs, Cycles permet d’utiliser la ou les cartes gra-
phiques de votre ordinateur. En effet, le lancer de rayon est une méthode
très facilement parallélisable, qui peut tirer un grand avantage de l’archi-
tecture fortement parallélisée des cartes graphiques modernes.

À titre comparatif, les processeurs haut de gamme destinés au grand
public ont actuellement entre 8 et 16 cœurs, ce qui permet de lancer au
maximum 16 rayons en parallèle pour le calcul de l’image. Les cartes
graphiques modernes, quant à elles, comptent plusieurs centaines, voire
des milliers de « cœurs », qui permettent de lancer autant de rayons en
parallèle. Le choix est donc vite fait, et si vous possédez une carte gra-
phique assez récente, elle vous sera indispensable pour éviter de longues
heures de calcul.

Comment activer le rendu par GPU ?
L’activation du rendu par la ou les cartes graphiques se fait en deux
étapes. Pour commencer, ouvrez les préférences utilisateur dans le menu
Edit>Preferences, puis cliquez sur le dernier onglet System. Dans l’option
Cycles  Render Devices, choisissez CUDA et sélectionnez la ou les cartes
graphiques que vous souhaitez utiliser pour le rendu. À noter qu’il est
possible de combiner le rendu de la carte graphique avec celui du proces-
seur en cochant toutes les options proposées.

De retour dans l’interface principale, dans l’onglet Render de la fenêtre
des propriétés, puis dans l’option Device, choisissez GPU Compute.

Figure 1–9
L’activation de la carte graphique se fait

dans les préférences utilisateur.
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Comment choisir sa carte graphique ?
À l’heure actuelle, deux constructeurs se partagent le marché des cartes
graphiques, chacun proposant une technologie spécifique pour le calcul.
Le leader du marché, Nvidia, embarque la technologie Cuda dans ses
cartes, alors que le challenger AMD préfère la technologie open source
OpenCL. Historiquement, Cycles a toujours fonctionné avec Cuda et il
était donc obligatoire d’avoir une carte de la marque Nvidia. Mais à partir
de la version 2.75, le support d’OpenCL pour l’accélération des calculs a
été ajouté, pour le plus grand bonheur des possesseurs de cartes AMD.

Le tableau 1-1 récapitule le support des fonctionnalités en fonction de la
méthode de calcul choisie.

Caractéristiques techniques
Le choix d’un nouveau matériel est toujours extrêmement technique et de
nombreux paramètres entrent en compte. Dans le cadre d’une utilisation
de Cycles, l’un des paramètres les plus importants à considérer sera la
quantité de VRAM que la carte embarque. Comptez au minimum 2 Go
pour pouvoir travailler confortablement, 4 si vous travaillez avec des

Figure 1–10
Activation du rendu GPU
dans la fenêtre des propriétés

Tableau 1–1 Comparatif des capacités des cartes graphiques en fonction de la marque

Fonctionnalité CPU CUDA AMD OpenCL

Shading Oui Oui Oui

Ombres transparentes Oui Oui Oui

Flou de mouvement Oui Oui Oui

Poils Oui Oui Oui

Volume Oui Oui Oui

Fumée/Feu Oui Oui Oui

Dispersion sous-surfacique Oui Oui Oui

Open Shading Language Oui Non Non

CMJ Sampling Oui Oui Oui

Intégrateur Branched Pach Oui Oui Oui

Displacement/Subdivision Oui (expérimental) Oui (expérimental) Oui (expérimental)
21
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scènes plus lourdes. Il n’y a pas de limite maximale à la quantité de
VRAM, les capacités des cartes augmentant de génération en génération.

L’autre choix important est bien sûr le nombre de cœurs logiques de la
carte graphique. Plus cette dernière en possède et plus le rendu sera rapide.

Enfin, d’autres paramètres sont à prendre en compte, tels que la connec-
tique de la carte graphique sur la carte mère. Assurez-vous d’avoir une
carte mère compatible avec les dernières cartes graphiques. La consom-
mation électrique de la carte est également importante, les rendus d’ani-
mation pouvant prendre plusieurs heures.

Le rendu par GPU ne fonctionne pas
Il est possible que le rendu par GPU ne fonctionne pas. L’image devient
alors complètement noire ou des messages d’erreur apparaissent à l’écran.

La première chose à faire est de vérifier que les pilotes de votre carte gra-
phique sont à jour et que celle-ci est supportée par Cycles. Pour les cartes
Nvidia, cela signifie que vous devez avoir une carte supportant Cuda 2.0
au minimum.

Si vous obtenez un message comme celui-ci :

CUDA error: Out of memory in cuLaunchKernel(cuPathTrace, xblocks,

yblocks, 1, xthreads, ythreads, 1, 0, 0, args, 0)

il est probable que vous ayez dépassé la quantité de VRAM disponible
dans votre carte graphique. La scène ne peut donc pas être chargée
entièrement dans celle-ci, ce qui empêche toute possibilité de rendu.

REMARQUE À propos des cartes graphiques professionnelles

Les deux constructeurs AMD et Nvidia proposent chacun une gamme de cartes graphiques
dédiée aux usages professionnels. Si, sur le papier, ces cartes sont techniquement au-dessus
de celles du marché grand public (certaines peuvent embarquer jusqu’à 12 Go de VRAM),
elles ne sont pas forcément adaptées au fonctionnement de Cycles et l’utilisateur ne gagnera
pas en performance sur le temps de rendu. Cela s’explique par le fait que les cartes profes-
sionnelles sont construites pour faire du calcul numérique comportant des nombres
« flottants » (nombres avec des virgules). Or, toute la logique interne de Cycles ne manipule
que des nombre entiers, rendant inutile la puissance de calcul des cartes « pro ».

BON À SAVOIR
Carte graphique non compatible

Si Blender affiche le message « No compatible
GPUs found for path tracing. Cycles will render on
the CPU. », cela signifie que votre ordinateur ne
possède pas de carte graphique reconnue et que le
rendu se fera automatiquement sur le processeur.
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chapitre 2

Steampunk Ship © 2016, Quentin Le Duff, https://www.artstation.com/papa_dragon



G67714-3D libre avec Blender-.book Page 25 Thursday, October 17, 2019 4:06 PM
Prise en main de Blender

Restée longtemps bien spécifique dans sa catégorie, l’interface
de Blender a su évoluer pour se montrer désormais plus
intuitive et moins déconcertante aux yeux des nouveaux
utilisateurs. Ce chapitre vous présentera les principaux
éléments cachés ou visibles de son interface, et vous aidera
à l’adapter à vos besoins. Dans ce chapitre, vous explorerez
pas à pas l’interface de Blender, et comment vous en servir.
Vous découvrirez en particulier les différentes vues, leur
manipulation, l’utilisation des raccourcis clavier et surtout,
de la souris.

SOMMAIRE

B Découverte de l’interface

B S’orienter dans l’espace virtuel
de Blender

B Actions fondamentales

MOTS-CLÉS

B Types de vues
B Vue 3D
B Panneaux latéraux
B Raccourcis clavier
B Utilisation de la souris
B Sélections des objets
B Manipulateurs
B Transformations
B Repères
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L’interface de Blender est remarquable et unique à plus d’un titre. Elle
peut paraître complexe et déroutante au premier abord mais elle se révèle
extrêmement simple et productive par la suite. Simple, car une fois fami-
liarisé avec la logique de l’organisation des données et des boutons de
Blender dans un menu (par exemple, les matériaux), on se rend compte
que ces données et ces boutons existent et fonctionnent selon la même
logique dans d’autres menus. Par exemple, on remarque rapidement que
la création de tout nouveau matériau ou de toute nouvelle texture (voir
les chapitres 5 et 6) repose chaque fois sur un même principe. De même,
dans un autre registre, l’édition d’un maillage dans la vue 3D, l’édition
d’une F-Curve dans l’éditeur de graphes ou le dépliage d’une carte UV
dans l’éditeur d’images reposent sur des manipulations étonnamment
semblables. Et il en va de même pour la plupart des menus, ce qui
démontre la robustesse et la consistance de l’interface.

L’interface de Blender est également qualifiée de productive car tout est
pensé pour vous simplifier les manipulations et, surtout, vous faire
gagner du temps. Les commandes se veulent immédiatement acces-
sibles, de plusieurs façons différentes, satisfaisant ainsi probablement
votre approche particulière de la modélisation ou de l’animation selon
que vous soyez, par exemple, un adepte des raccourcis clavier, des icônes
ou de l’usage des menus. Depuis les premières versions, les raccourcis
clavier et les combinaisons de touches ont occupé dans Blender une
place prépondérante, voire incontournable, permettant de réaliser très
rapidement des actions particulièrement complexes par une simple suc-
cession de raccourcis clavier. Malheureusement, le fait de devoir mémo-
riser la trentaine de combinaisons absolument essentielles a largement
contribué à forger la réputation de Blender, dont on parlait, il y a
quelques années, comme d’un logiciel complexe et difficile à maîtriser,
surtout pour les débutants, qui parfois n’arrivaient à rien en tirer !

Depuis, les choses ont évolué, car les développeurs de Blender ont pris en
compte les demandes de leurs utilisateurs et se sont efforcés d’améliorer
l’ergonomie de l’interface au travers d’icônes, de menus et sous-menus, et
de boutons organisés d’une façon rationnelle (et parfois un peu trop
proche de certains modèles commerciaux concurrents), tout en préservant
la multiplicité des raccourcis clavier qui en ont fait toute la force.

REMARQUE La règle à retenir absolument

La règle d’or de Blender n’a jamais changé en plu-
sieurs années d’existence; si vous souhaitez en
tirer le meilleur parti : « Une main sur le cla-
vier, une main sur la souris ».
En effet, la plupart des raccourcis clavier peuvent
être effectués d’une seule main et appellent une
action en retour à la souris. En gardant cette règle
en mémoire à chaque instant de votre travail avec
Blender, vous constaterez que votre souris fera
considérablement moins d’allers-retours entre les
boutons, les menus et les autres recoins de l’inter-
face graphique, pour se concentrer sur la seule
chose qui doit vraiment retenir votre attention : la
scène sur laquelle vous travaillez. Vous économi-
serez du temps, vous vous fatiguerez moins et
vous serez plus efficace et plus productif.
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Découverte de l’interface graphique

L’écran d’accueil
Dès le démarrage de Blender, l’écran d’accueil offre des fonctionnalités
pouvant aider l’utilisateur à démarrer plus facilement :
• La section Newfile présente une collection d’espaces de travail diffé-

rents, spécifiques selon vos besoins, lorsque vous commencez un
projet. Ils sont bien évidemment modifiables et peuvent être réorga-
nisés à votre guise à tout moment :
– General est l’agencement par défaut et permet rapidement d’accéder

à toutes les fonctions de Blender ;
– 2D Animation est dédié à l’animation de vos illustrations réalisées

avec le Grease Pencil, un des récents outils puissants de Blender. Il
existe un environnement pour toutes les étapes : dessin/animation,
composition et rendu ;

– Sculpting ouvre Blender directement sur une vue 3D spécialement
adaptée à la sculpture numérique avec une sphère prête à être
modelée ;

– VFX est spécifiquement paramétré pour le travail d’incrustation
d’effets spéciaux et comprend donc un environnement pour les étapes
de tracking, de mise en place de masques, de compositing et de rendu ;

– Video Editing permet, comme son nom l’indique, d’ouvrir Blender
sur un environnement dédié à l’édition de vidéos.

Figure 2–1
L’écran d’accueil présente des fonctionnalités
qui aident l’utilisateur à démarrer
plus rapidement son activité.
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